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กิตติกรรมประกาศ 
 

การจัดทำรายงานการปฏิบัติสหกิจศึกษาครั้งนี้ สำเร็จลุล่วงได้ด้วยความช่วยเหลืออย่างดียิ่งจาก 

พนักงานที่ปรึกษารายงานการปฏิบัติสหกิจศึกษา นายวรวุฒิ ประทุมตรี อาจารย์ที่ปรึกษารายงานการ

ปฏิบัติสหกิจศึกษา ดร.ศุภชานันท์ วนภู ดร.เจนจีรา อักษรพิมพ์ ดร.จินตนา โต้งสูงเนิน ที่ได้กรุณาสละ

เวลาให้คำปรึกษา แนะนำ และให้ข้อมูลที่เป็นประโยชน์อย่างยิ่งในการศึกษาครั้งนี้ 

คณะผู้จัดทำรู้สึกซาบซึ้งในความกรุณาของอาจารย์และขอกราบขอบพระคุณเป็นอย่างสูงไว้ ณ 

ที่นี้ด้วย ขอขอบพระคุณพ่ี ๆบุคคลากรแผนกสารสนเทศ โรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี ที่ให้

ความรู้และให้ประสบการณ์ในการทำงานที่สามารถนำไปประยุคใช้ได้ในอนาคต และขอขอบพระคุณคณะ

อาจารย์ คณะวิทยาการจัดการ ทุกท่านที่ให้การอบรมสั่งสอน ให้ความรู้เรื่องการเขียนโปรแกรมต่าง ๆ ใน

การพัฒนาระบบ ช่วยส่งผลให้ผู้จัดทำนำความรู้ที่ได้มาประยุกต์ใช้ในรายงานการปฏิบัติสหกิจศึกษาครั้งนี้

ได้เป็นอย่างดี ขอขอบคุณห้องยาแผนกเภสัชกรรม โรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี ที่เมตตาให้

ความร่วมมือและให้ข้อมูลต่าง ๆ ในเรื่องการเช็คยาฉุกเฉิน ขอขอบคุณเพื่อน ๆ ที่ช่วยให้คำแนะนำดี ๆ 

เกีย่วกับรายงานการปฏิบัติสหกิจศึกษาจนทำให้โครงการสำเร็จลุล่วงไปได้ด้วยดี 

   

 

คณะผู้จัดทำ 

 
 

  



ชื่อเรื่อง        การศึกษาระบบต้นแบบการแจ้งเตือนยา STAT แผนกเภสัชกรรม โรงพยาบาล

มหาวิทยาลัยเทคโนโลยีสุรนารี 
ผู้ศึกษา         นายเปรมศักดิ์ ปทุมานันท์ นางสาวปทิตตา รักษ์พุทธชนม์ นางสาวเสาวรัตน์ ดำขำ 

ที่ปรึกษา       ดร.ศุภชานันท์ วนภู ดร.จินตนา โต้งสูงเนิน ดร.เจนจีรา อักษรพิมพ์  

ปริญญาตรี    บริการธุรกิจบัณฑิต (บธ.บ) สาขาคอมพิวเตอร์ธุรกิจ 

 

บทคัดย่อ 

วัตถุประสงค์ของรายงานการปฏิบัติสหกิจศึกษานี้ เป็นการจัดทำระบบต้นแบบการแจ้งเตือนยา 

STAT แผนกเภสัชกรรม โรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี โดยการศึกษาระบบต้นแบบการแจ้ง

เตือนยา STAT แผนกเภสัชกรรม โรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี  เพื่ออำนวยความสะดวก

ให้กับห้องยาแผนกเภสัชกรรม โรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี ที่ทำการเช็คยา  Stat ในการ

พัฒนาระบบนั้นได้ศึกษาตั้งแต่วิธีการจัดเก็บข้อมูล วิธีการประมวลผลของระบบงานเดิม เพ่ื อนำมา

ประยุกต์ใช้ในการพัฒนาระบบใหม่ อีกท้ัง ยังต้องศึกษาจุดบกพร่องของระบบงานเดิม เพ่ือนำมาแก้ไขและ

ปรับปรุงให้มีการทำงานที่ดีขึ้น โดยการนำเทคโนโลยีของสรรพสิ่งหรือ IoT มาปรับใช้ ซอฟต์แวร์ที่ใช้ใน

การพัฒนาระบบ คือ โปรแกรม Arduino เป็นเครื่องมือที่ใช้สำหรับเขียดโค้ดลงกับบอร์ดอาดูโน่  เป็น

บอร์ดไมโครคอนโทรเลอร์ตระกูล AVR ที่มีการพัฒนาแบบ Open Source คือมีการเปิดเผยข้อมูลทั้งด้าน 

Hardware และ Software ตัว บอร์ด Arduino ถูกออกแบบมาให้ใช้งานได้ง่าย ดังนั้นจึงเหมาะสำหรับผู้

เริ่มต้นศึกษา ทั้งนี้ผู้ใช้งานยังสามารถดัดแปลง เพ่ิมเติม พัฒนาต่อยอดทั้งตัวบอร์ด หรือโปรแกรมต่อได้อีก

ด้วย และใช้ Load cell เป็นตัวชั่งน้ำหนักยา Stat 

การทำการจะต้องเชื่อมต่ออินเทอร์เน็ตใช้บอร์ดอาดูโน่ในการชั่งน้ำหนักผ่านตัว Sensor Load 

cell และเครื่องจะทำงานชั่งน้ำหนักยาและทำการตรวจสอบเงื่อนไขว่าต่ำกว่าเกณฑ์ท่ีกำหนดหรือไม่ หาก

น้ำหนักต่ำกว่าเกณฑ์เครื่องจำทำการแจ้งเตือนไปที่ไลน์ และไฟ LED จะติดที่กระบะเก็บยา และจะมีการ

เก็บข้อมูลจำนวนยาลง Database  และทำการออก Report ไปยังไลน์ของ User จากการดำเนินการ

ทดลองใช้อุปกรณ์ในการชั่งน้ำหนักผลปรากฏว่าอุปกรณ์ในการชั่งนั้นสามารถชั่งน้ำหนักและแจ้งเตือนไป

ยัง Line Notify ได้ แต่ในการชั่งน้ำหนักที่มีปริมาณน้อยมากๆ อาจทำให้ปริมาณไม่คงที่ผู้พัฒนาจึงศึกษา

ระบบต้นแบบต่อไป 
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บทที่ 1 

บทนำ 
 

1. ความเป็นมาและความสำคัญ    

แผนกเภสัชกรรมมีหน้าที่รับผิดชอบด้านการบริการทางเภสัชกรรมและพัฒนาระบบการจัดและการ

ใช้ยาและเวชภัณฑ์ให้ได้คุณภาพ มาตรฐาน ปลอดภัย มีประสิทธิภาพ ตั้งแต่การคัดเลือกจัดหาการผลิต

ควบคุมคลัง การจัดจ่าย การตวงยาหรือการชั่งยาจึงเป็นสิ่งที่สำคัญ   การชั่งเพื่อกำกับตัวยาที่แน่นอนในการ

นำมาใช้รักษาคนไข้ (โรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี, 2558)  

          ปัจจุบันห้องยาแผนกเภสัชกรรมมียาฉุกเฉินที่ต้องพร้อมจ่ายตลอดเวลา ซึ่งหากเกิดกรณียาหมดอาจ

ส่งผลกระทบต่อผู้ป่วย ซึ่งโดยปัจจุบันทางห้องยาแผนกเภสัชกรรมได้ใช้วิธีเช็คยาฉุกเฉินด้ วยวิธีเช็คลิส      

เช้า-เย็น จึงทำให้ระหว่างวันไม่ทราบได้ว่ายาหมดหรือไม่ จึงต้องมีการเช็คตลอดเวลา  

           เพ่ือช่วยแผนกเภสัชกรรมในการตรวจสอบยา Stat จึงมีแนวคิดพัฒนาระบบการแจ้งเตือนยาฉุกเฉิน 

โดยมีการใช้แนวคิดทฤษฎีเทคโนโลยีของสรรพสิ่งหรือ IoT ด้วยการใช้บอร์ดอาดูโน่กับระบบเครื่องชั่งในการ

ตรวจสอบปริมาณยาฉุกเฉินหากมีปริมาณน้อยกว่าที่กำหนดจะมีการแจ้งเตือนผ่านทางระบบ Line Notify 

และสัญญาณไฟ LED 

 

2. วัตถุประสงค์ของโครงการการปฏิบัติงาน 

2.1 เพ่ือแจ้งเตือนในเวลาที่ยาฉุกเฉินปริมาณน้อยกว่าที่กำหนด ภายในแผนกเภสัชกรรม 

2.2 เพ่ือลดความผิดพลาดในการตรวจสอบสต็อกยาอันตราย 

2.3 เพ่ือเพ่ิมช่องทางในการตรวจสอบสต็อกยาแก่บุคลากรได้สะดวกยิ่งขึ้น 

 

3. ขอบเขตการดำเนินโครงการการปฏิบัติงาน 

การจัดทำโครงการพัฒนาเครื่องแจ้งเตือนยาฉุกเฉินโดยใช้บอร์ด Arduino ในการพัฒนาให้กับแผนก
เภสัชกรรมโรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี ที่ตั้ง 111 ถ.มหาวิทยาลัย ตำบลสุรนารี อำเภอเมือง
นครราชสีมา จังหวัดนครราชสีมา 30000  เพื่ออำนวยความสะดวกในการปฏิบัติงานให้มีประสิทธิภาพมาก
ยิ่งขึ้น 
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เงื่อนไขการทำงาน 
3.1 การชั่งยาฉุกเฉิน 

3.1.1 มีการชั่งยาฉุกเฉิน 
3.1.2 เครื่องชั่งยาสามารถชั่งยาได้น้ำหนักท่ีไม่เกิน 10 กิโลกรัม 

3.2 การแจ้งเตือน 
3.2.1 แจ้งเตือนผ่าน Line Notify เมื่อยาฉุกเฉินน้อยกว่ากำหนด 
3.2.2 แจ้งเตือนผ่าน ไฟ LED ที่กระบะเก็บยาฉุกเฉินเมื่อยาฉุกเฉินน้อยกว่ากำหนด 

3.3 การเก็บข้อมูล 
3.3.1 เก็บข้อมูลยา Stat ที่น้อยกว่ากำหนดตลอดเวลา 
 

4. ประโยชน์ที่คาดว่าจะได้รับ 

4.1 สามารถทำให้เจ้าหน้าที่เติมยาในขณะปฏิบัติงานได้ทันท่วงที 

4.2 สามารถเพ่ิมประสิทธิภาพในการทำงานการของแผนกจ่ายยา ทำให้ยาเพียงพอต่อการจ่ายยา 

4.3 สามารถเก็บข้อมูลรายละเอียดและความถ่ีในการเติมยาในแต่ละวัน 

 

5. นิยามศัพท์เฉพาะ 

แผนกเภสัชกรรม หมายถึง แผนกที่มีหน้าที่ในการดูแลและจ่ายยาของโรงพยาบาลมหาวิทยาลัย

เทคโนโลยีสุรนารี 

เครื่องชั่งยา หมายถึง เครื่องชั่งยาฉุกเฉินในแผนกเภสัชกรรม โรงพยาบาลมหาวิทยาลัยเทคโนโลยี

สุรนารี 

ยาที่ให้ทันที หรือ ยา Stat (Stat Drug) หมายถึง ยาที่ให้แก่ผู้ป่วยที่จำเป็นต้องได้รับการรักษาอย่าง

เร่งด่วน แต่ไม่ใช่ยาฉุกเฉิน (Emergency drug) หากผู้ป่วยไม่ได้รับยา จะเพิ่มความเสี่ยงต่อการเสียชีวิตของ

ผู้ป่วย  

Load cell หมายถึง เซนเซอร์ที่สามารถแปลงค่าแรงกด หรือแรงดึง ให้เป็นสัญญาณทางไฟฟ้าได้ 

โดยการเปลี่ยนแปลงค่าความต้านทานตาม แรงกด หรือ แรงดึง  

Firebase หมายถึง เป็นตัวเก็บข้อมูลเครื่องแจ้งเตือนยาฉุกเฉิน 

Line Notify หมายถึง แอพพลิเคชั่นสำหรับการแจ้งยาฉุกเฉินในแผนกเภสัชกรรม



บทที่ 2 
ข้อมูลสถานประกอบการและเอกสารที่เกี่ยวข้อง 

 
 โครงการสหกิจศึกษาเรื่อง ที่ แผนกเภสัชกรรม โรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี คณะ

ผู้จัดทำได้ศึกษา แนวคิด ทฤษฎี ข้อมูลของสถานประกอบการ และตัวอย่างของระบบงานที่เกี่ยวข้อง ดังนี้ 
1. รายละเอียดเกี่ยวกับโรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี 
2. แนวคิดและทฤษฎีที่เกี่ยวข้อง 
3. วิจัยที่เกี่ยวข้อง 

1. รายละเอียดเกี่ยวกับโรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี 
1.1 ชื่อและท่ีตั้งของสถานประกอบการ 

โรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี ตั้งอยู่ภายในบริเวณมหาวิทยาลัยเทคโนโลยีสุรนารี 

ใกล้กับประตูทางออกที่ 2 ของมหาวิทยาลัยฯ ได้เปิดให้บริการในชื่อของศูนย์ปฏิบัติการทางการแพทย์

และสาธารณสุข ตั้งแต่วันที่ 2 กรกฎาคม 2553เป็นต้นมา โดยเปิดบริการแบบผู้ป่วยนอก สามารถให้ 

บริการตรวจรักษาโรคทั่วไป อุบัติเหตุฉุกเฉินตลอด 24 ชั่วโมง  พร้อมให้บริการผู้ป่วยสำหรับ “อาคารรัตน

เวชพัฒน์” ในวันที่ 18 พฤศจิกายน 2557       

ซึ่งจะสามารถรองรับการให้บริการผู้ป่วยในและผู้ป่วยวิกฤติแก่ประชาชนเพิ่มขึ้นโดยเฉพาะใน

พ้ืนที่จังหวัดนครราชสีมา ครอบคลุมถึงเขตภาคตะวันออกเฉียงเหนือตอนล่าง นอกเหนือจากการให้บริการ

ทางสุขภาพแล้ว โรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารียังมีพันธกิจสำคัญในการร่วมผลิตบัณฑิตและ

เป็นสถาบันแห่งการเรียนรู ้ของบัณฑิตและบุคลากรทางการแพทย์ทุกระดับ  และการเปิดให้บริการ

โรงพยาบาลมหาวิทยาลัยฯนี้ จะยังประโยชน์ในการจัดการศึกษา ค้นคว้าวิจัย และเพิ่มพูนประสบการณ์

การเรียนรู้ทางคลินิกให้แก่คณาจารย์ นักศึกษาแพทย์ พยาบาล สาธารณสุข และสาขาท่ีเกี่ยวข้องทางด้าน

วิทยาศาสตร์สุขภาพ  อีกทั้งยังเป็นหน่วยรองรับและให้บริการทางการแพทย์และสาธารณสุขแก่นักศึกษา 

บุคลากร และประชาชนโดยรอบมหาวิทยาลัย   อันจะช่วยแบ่งเบาภาระการดูแลรักษาผู ้ป่วยให้แก่

โรงพยาบาลในจังหวัดนครราชสีมาและจังหวัดใกล้เคียง 
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1.2 พันธกิจ – วิสัยทัศน์ 

1.2.1 วิสัยทัศน์  

โรงพยาบาลมหาวิทยาลัยชั้นนำของประเทศ และเป็นที่พ่ึงของสังคม 

1.2.2 พันธกิจ  

1.2.2.1 สนับสนุนการผลิตบัณฑิตและบุคลากรทางการแพทย์ทุกระดับ  

1.2.2.2 ศูนย์กลางการวิจัยด้านวิทยาการที่ทันสมัย  

1.2.2.3 ให้บริการทางการแพทย์ที่ได้มาตรฐานสากลอย่างมีคุณภาพและคุณธรรม 

1.2.2.4 สร้างเสริมสุขภาพอนามัยและคุณภาพชีวิตของประชาชน 

1.3 ค่านิยมหลัก  

1.3.1 S = Systems Thinking : ทุกอย่างเป็นระบบ  

1.3.2 U = United of Qualities : เป็นหนึ่งด้านคุณภาพ  

1.3.3 T = Teamworks & Technology : ทำงานเป็นทีมและใช้เทคโนโลยีเป็นฐาน  

1.3.4 H = Humanize Care : บริการด้วยใจ 

1.4 ยุทธศาสตร์ ปี 2563-2565  

1.4.1 ขยายบริการทางการแพทย์ให้ครอบคลุมกลุ่มเป้าหมาย 

1.4.2 การเป็นโรงพยาบาล Smart Hospital  

1.4.3 พัฒนาการเรียนการสอนบนความร่วมมือของกลุ่มวิทยาศาสตร์สุขภาพครั้งก่อน

ปริญญาและหลังปริญญา  

1.4.4 พัฒนางานวิจัยเพื่อประโยชน์ในการดูแลสุขภาพของประชาชนและสังคม 

1.4.5 พัฒนาบุคลากรให้มีสมรรถนะและส่งเสริมคุณภาพชีวิตการทำงานอย่างยั่งยืน  

1.4.6 บริหารทรัพย์สินให้มีประสิทธิภาพสูงสุด 

1.5 จุดมุ่งเน้น 

1.5.1 2P Safety Goal เพ่ือความปลอดภัยของผู้รับบริการและผู้ให้บริการ  

1.5.2 ยกระดับพฤติกรรมบริหารการสู่การบริการที่เป็นเลิศ  

1.5.3 การเปิดอาคารความเป็นเลิศและขยายบริการผู้ป่วยนอกเพ่ือเพ่ิมจำนวนผู้ป่วยใน

ให้เป็นไปตามเป้าหมาย 
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1.6 วัตถุประสงค์เชิงกลยุทธ์ 

1.6.1 เพ่ิมศักยภาพและคุณภาพการให้บริการ 

1.6.2 สร้างเครือข่าย ทางการรักษาตามศักยภาพโรงพยาบาล 

1.6.3 เพ่ิมบริการที่แตกต่างจากโรงพยาบาลรัฐทั่วไป สำหรับกลุ่มประชาชนเฉพาะ  

1.6.4 พัฒนาโรงพยาบาลสู่ Smart เทคโนโลยี Lean healing Hospital   

1.6.5 ผ่านการประเมินมาตรฐานโรงพยาบาลและมาตรฐานการเรียนการสอนโดยสภา

วิชาชีพต่าง ๆ  

1.6.6 เพ่ิมศักยภาพการวิจัยและนวัตกรรมที่เกดิจากความร่วมมือระหว่างโรงพยาบาล

มหาวิทยาลัยและเครือข่ายต่าง ๆ 

1.7 การให้บริการทางการแพทย์ – พยาบาล 

โรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารีมีการให้บริการทางการแพทย์แบ่งเป็น 5 

ส่วนงานดังนี้ 

1.7.1 คลินิกแพทย์เฉพาะทาง  

1.7.1.1 คลินิกเวชปฏิบัติทั่วไป 

1.7.1.2 คลินิกเวชศาสตร์ครอบครัว 

1.7.1.3 คลินิกแพทย์เฉพาะทางสูตินรีเวช 

1.7.1.4 คลินิกศัลยกรรม 

1.7.1.5 คลินิกแพทย์เฉพาะทางศัลยกรรมกระดูกและข้อ 

1.7.1.6 คลินิกศัลยกรรมระบบประสาท 

1.7.1.7 ศัลยกรรมระบบทางเดินปัสสาวะ 

1.7.1.8 คลินิกแพทย์เฉพาะทางอายุรกรรม 

1.7.1.9 คลินิกอายุรกรรมโรคปอด 

1.7.1.10 คลินิกแพทย์เฉพาะทางกุมารเวช 

1.7.1.11 คลินิกแพทย์เฉพาะทางหู คอ จมูก 

1.7.1.12 คลินิกแพทย์เฉพาะทางตา 

1.7.1.13 คลินิกสุขภาพจิต 
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1.7.1.14 คลินิกแพทย์เฉพาะทางรังสี 

1.7.1.15 แผนกเวชศาสตร์ฟื้นฟู 

1.7.1.16 คลินิกกายภาพบำบัด 

1.7.1.17 ศูนย์ตรวจสุขภาพ 

1.7.2 บริการสนับสนุนทางการแพทย์ 

1.7.2.1 แผนกรังสีวิทยา 

1.7.2.2 บริการแผนกเภสัชกรรม 

1.7.2.3 บริการแผนกห้องปฏิบัติการ 

1.7.2.4 การบริการของแผนกอุบัติเหตุฉุกเฉิน 

1.7.3 คลินิกบริการพิเศษ 

1.7.3.1 คลินิกทันตกรรม 

1.7.3.2 คลินิกตรวจการนอนหลับ 

1.7.3.3 หน ่วยเทคโนโลย ีช ่ วยการเจร ิญพ ันธ ุ ์  (Assisted Reproductive 

Technology Unit) 

1.7.4 ฝ่ายการพยาบาล 

1.7.4.1 ฝ่ายบริหารแผนงานและทรัพยากรมนุษย์ 

1.7.4.2 ฝ่ายบริการคุณภาพทางการพยาบาล 

1.7.4.3 ฝ่ายวิชาการและวิจัยทางการพยาบาล 

1.7.5 แผนกทางการพยาบาล 

1.7.5.1 แผนกงานการศึกษาและวิชาการทางการพยาบาล 

1.7.5.2 แผนกผู้ป่วยนอก 1 

1.7.5.3 แผนกผู้ป่วยนอก 2 

1.7.5.4 แผนกผู้ป่วยนอก 3 

1.7.5.5 แผนกสร้างเสริมสุขภาพ 

1.7.5.6 แผนกอุบัติเหตุและฉุกเฉิน 

1.7.5.7 แผนกหอผู้ป่วยทารกแรกเกิดและทารกแรกเกิดวิกฤติ 
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1.7.5.8 แผนกหอผู้ป่วยวิกฤติ 

1.7.5.9 แผนกหอผู้ป่วยสามัญ 1 

1.7.5.10แผนกหอผู้ป่วยสามัญ 2 

1.7.5.11 แผนกหอผู้ป่วยพิเศษ 

1.7.5.12 แผนกไตเทียม 

1.7.5.13 แผนกสูตินรีเวช 

1.7.5.14 แผนกพยาบาลวิสัญญี 

1.7.5.15 แผนกห้องผ่าตัด 

1.7.5.16 แผนกเวชภัณฑ์และเครื่องมือปราศจากเชื้อ 

                         1.7.5.17 แผนกห้องปฏิบัติการสวนหัวใจและหลอดเลือด 

1.8 ลักษณะท่ีนักศึกษาสหกิจได้รับมอบหมายให้รับผิดชอบ 

        IT SUPPORT  

1.9 พนักงานที่ปรึกษา ตำแหน่งงานภายในแผนกสารสนเทศ 

        นายวรวุฒิ   ประทุมตรี   ที่ปรึกษาโปรเจคสหกิจศึกษา 

        นายอัชชา  คิดเห็น         ที่ปรึกษางาน IT Support 
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2. แนวคิดและทฤษฎีที่เกี่ยวข้อง 

2.1 แนวคิดอินเทอร์เน็ตทุกสรรพสิ่ง (Internet of Things : IoT) 

 2.1.1 แนวคิดอินเทอร์เน็ตทุกสรรพสิ่ง (IoT)  

แนวคิดอินเทอร์เน็ตทุกสรรพสิ ่ง ถูกคิดขึ ้นโดย Kevin Ashton ในปี 1999 เริ ่มต้น

โครงการ Auto-ID Center ที่มหาวิทยาลัย Massachusetts Institute of Technology หรือ MIT จาก

เทคโนโลยี RFID ที่จะทำให้เป็นมาตรฐานระดับโลกสำหรับ RFID Sensors ต่าง ๆ ที่จะเชื่อมต่อกันได้มี

โครงสร้างพื้นฐานที่สามารถเชื่อมต่อกับอินเทอร์เน็ตได้ และสามารถเชื่อมต่อไปยังอุปกรณ์ตัวอื่น ๆ ได้

ด้วย (สมนึก จริะศิริโสภณ, 2559) 

 2.1.2 ความหมายและความสำคัญของ อินเทอร์เน็ตทุกสรรพสิ่ง (IoT)  

คำว่า อินเทอร์เน็ตเพื่อสรรพสิ่ง ( Internet of Things) หรือ IoT มีผู้ทรงคุณวุฒิและ

นักวิชาการได้ให้ความหมายไว้ในอย่างหลากหลาย ดังนี้   

วิว ัฒน์ มีสุวรรณ์ (2559) ได้ให้ความหมายของคำว่า อินเทอร์เน็ตเพื ่อสรรพสิ่ง 

(Internet of Things) หรือ IoT เป็นการใช้ประโยชน์จากความก้าวหน้าของเครือข่ายอินเทอร์เน็ตและ

การเพ่ิมข้ึนของข้อมูลสารสนเทศจำนวนมาก (Big Data) จากอุปกรณ์หรือสรรพสิ่งต่าง ๆ ที่อยู่รอบตัวให้

สามารถนำมาใช้ประโยชน์ได้อย่างเหมาะสม 

ศูนย์เทคโนโลยีอิเล็กทรอนิกส์และคอมพิวเตอร์แห่งชาติ (2561) ได้กล่าวถึง Internet 

of Things หรือIoT คือ สภาพแวดล้อมอันประกอบด้วยสรรพสิ่งที่สามารถสื่อสารและเชื่อมต่อกันได้ผ่าน

โพรโทคอลการสื่อสารทั้งแบบใช้สายและไร้สาย โดยสรรพสิ่งต่าง ๆ มีวิธีการระบุตัวตนได้ รับรู้บริบทของ

สภาพแวดล้อมได้ และมีปฏิสัมพันธ์โต้ตอบและทำงานร่วมกันได้ ความสามารถในการสื่อสารของสรรพสิ่ง

นี ้จะนำไปสู ่นวัตกรรมและบริการใหม่อีกมากมาย ตัวอย่างเช่น เซ็นเซอร์ภายในบ้านตรวจจับการ

เคลื่อนไหวของผู้อยู่อาศัย และส่งสัญญาณไปสั่งเปิดหรือปิดสวิตซ์ไฟตามห้องต่าง ๆ ทีม่ีคนหรือไม่มีคนอยู่ 

อุปกรณ์วัดสัญญาณชีพของผู้ป่วยผู้สูงอายุและส่งข้อมูลไปยังบุคลากรทางการแพทย์ หรือส่งข้อความเรียก

หน่วยกู้ชีพหรือรถฉุกเฉิน เป็นต้น 

สถาบันส่งเสริมการสอนวิทยาศาสตร์และเทคโนโลยี (2561) ให้คำอธิบายเกี่ยวกับ 

Internet of Things (IoT) คือ เทคโนโลยีที่ทำให้อุปกรณ์ต่าง ๆ สามารถแลกเปลี่ยนข้อมูลกันได้ผ่าน

เครือข่ายอินเทอร์เน็ต โดยมีสภาพแวดล้อมที่ประกอบด้วยอุปกรณ์ต่าง  ๆ มีการถ่ายโอนข้อมูลร่วมกัน
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ผ่านเครือข่าย โดยไม่จำเป็นต้องใช้ปฏิสัมพันธ์ระหว่างบุคคลกับบุคคล หรือระหว่างบุคคลกับคอมพิวเตอร์ 

พ ัฒนามาจากเทคโนโลยีไร ้สาย (wireless technology) ระบบเคร ื ่องกลไฟฟ้าจุลภาค (micro-

electromechanical systems: MEMS) และอินเทอร์เน็ตซึ ่งคำว่า Things ใน Internet of Things 

หมายถึงอุปกรณ์ต่าง ๆ ที่อ้างอิงได้ด้วยตัวเลขไอพี (IP address) และมีความสามารถในการถ่ายโอน

ข้อมูลระหว่างกันได้ผ่านเครือข่าย 

เสกสรร ศิวิลัย (2561) Internet of Things คือ การที่สิ่งต่าง ๆ รอบตัวเราถูกเชื่อมโยง

เข้าด้วยกันบนโลกของอินเทอร์เน็ต ซ่ึงทำให้เราสามารถควบคุมหรือสั่งการอุปกรณ์ต่าง ๆ ได้ไม่ว่าจะเป็น

การเปิด-ปิดไฟแอร์ โทรทัศน์ ฯลฯ ผ่านทางเครือข่ายอินเทอร์เน็ตด้วยสมาร์ทโฟน คอมพิวเตอร์ หรือ

อุปกรณ์พกพาอื่น ๆนอกจากสิ่งต่าง ๆ รอบตัวเราแล้ว IoT ยังถูกนำไปใช้กับทางการแพทย์ การเกษตร 

เครื่องจักรกลในโรงงานอุตสาหกรรม และอ่ืน ๆ อีกมากมาย 

นอกจากนั้นยังมี สุวิทย์ ภูมิฤทธิกุล และปานวิทย์ ธุวะนุติ (2559) ได้ให้ความหมายของ

คำว่า Internet of Things ว่าเป็นการทำอุปกรณ์ใด ๆ หรือสรรพสิ่งใด ๆ ให้ฉลาดขึ้น โดยการใส่สมอง

กลให้กับอุปกรณ์นั้นแล้วให้สรรพสิ่งนั้น ๆ สามารถสื่อสาร ควบคุม หรือรายงานผลซึ่งกันและกันได้ผ่าน

อินเทอร์เน็ต 

เทคโนโลยี Internet of Things (IoT) หรือ “อินเตอร์เน็ตในทุกสิ่ง” หมายถึง การที่สิ่ง

ต่าง ๆ ถูก เชื่อมโยงทุกสิ่งทุกอย่างเข้าสู่โลกอินเทอร์เน็ต ทำให้มนุษย์สามารถสั่งการ ควบคุมใช้งาน

อุปกรณ์ต่าง ๆ ผ่านทางเครือข่ายอินเตอร์เน็ต เช่น การสั่งเปิด-ปิด อุปกรณ์เครื่องใช้ไฟฟ้า รถยนต์ 

โทรศัพท์มือถือ เครื่องมือ สื่อสาร เครื่องใช้สำนักงาน เครื่องมือทางการเกษตร เครื่องจักรในโรงงาน

อุตสาหกรรม อาคาร บ้านเรือน เครื่องใช้ในชีวิตประจำวันต่าง ๆ ผ่านเครือข่ายอินเทอร์เน็ต เป็นต้น โดย

เทคโนโลยีนี้จะเป็นทั้งประโยชน์อย่าง มหาศาล และความเสี่ยงไปพร้อม ๆ กัน เพราะหากระบบรักษา

ความปลอดภัยของอุปกรณ์และเครือข่าย อินเทอร์เน็ตไม่ดีพอ จะทำให้ผู้ไม่ประสงค์ดีเข้ามากระทำการที่

ไม่พึงประสงค์ต่ออุปกรณ์ข้อมูลสารสนเทศ หรือความเป็นส่วนตัวของบุคคลได้ ดังนั้น การพัฒนาไปสู่ 

Internet of Things จึงมีความจำเป็นต้อง พัฒนามาตรการและเทคนิคในการรักษาความปลอดภัยไอที

ควบคู่กันไปด้วย  หรือบางแห่งเรียก M2M ย่อมาจาก Machine to Machine คือ เทคโนโลยีอินเตอร์เน็ต

ที่เชื่อมอุปกรณ์กับเครื่องมือต่าง ๆ เช่น โทรศัพท์มือถือ รถยนต์ ตู้เย็น โทรทัศน์ และอ่ืน ๆ เข้าไว้ด้วยกัน 

โดยการ เชื่อมโยงช่วยให้สื่อสารกันได้ผ่านระบบอินเตอร์เน็ต การคาดการณ์ ในปี ค.ศ. 2020 สิ่งต่างๆ 
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กว่าแสนล้านชิ้นจะสามารถเชื่อมต่อกันได้ด้วยระบบ IoT ซึ่งจะส่งผลให้ผู้บริโภคทั่วไปจะเริ่มคุ้นเคยกับ

เทคโนโลยีที่ทำให้พวก เขา สามารถควบคุมสิ่งของต่าง ๆ ทั้งจากในบ้านและสำนักงานหรือจากท่ีไหนก็ได้

ทั้งนั้น (มหศักดิ ์เกตฉุ่ำ, 2555) 

อินเตอร์เน็ตในทุกสิ่ง (Internet of Things) คือ สภาพแวดล้อมที่ประกอบด้วยอุปกรณ์

ที่มีการถ่ายโอนข้อมูลร่วมกันโดยผ่านเครือข่าย จึงไม่จำเป็นต้องใช้ปฏิสัมพันธ์ระหว่างบุคคลกับบุคคล 

หรือระหว่างบุคคลกับคอมพิวเตอร์ ซึ ่ง Internet of Things ได้พัฒนา มาจากเทคโนโลยีไร ้สาย 

(wireless technology) ระบบเครื่องกลไฟฟ้าจุลภาค (micro-electromechanical system: MEMS) 

และอินเทอร์เน็ต คำว่า Things ใน Internet of Things นั้น หมายถึง อุปกรณ์ที่อ้างอิงได้ด้วยเลขไอพี 

(IP address) และมี ความสามารถในการถ่ายโอนข้อมูลระหว่างกันได้โดยผ่านเครือข่าย สรุปอย่างให้

เข้าใจง่าย Internet of Things คือ เทคโนโลยี ที่ทำให้อุปกรณ์ต่าง ๆ สามารถแลกเปลี่ยนข้อมูลระหว่าง

กันได้ผ่านเครือข่ายอินเทอร์เน็ต (วชิรพรรณ ทองวิจิตร, 2559) 

ดังนั ้น อินเตอร์เน ็ตในทุกสิ ่ง (Internet of Things) หมายถึง สภาพแวดล้อมที่

ประกอบด้วยอุปกรณ์ที่มีการถ่ายโอนข้อมูลร่วมกันโดยผ่านเครือข่ายระหว่างบุคคลกับบุคคล หรือ

ระหว่างบุคคลกับคอมพิวเตอร์ เชื่อมโยงทุกสิ่งทุกอย่างเข้าสู่โลกอินเทอร์เน็ต ทำให้มนุษย์สามารถสั่งการ 

ควบคุมใช้งานอุปกรณ์ต่าง ๆ ผ่านทางเครือข่ายอินเตอร์เน็ต 

  2.1.3 การเชื่อมต่ออุปกรณ์ต่าง ๆ เข้ากับโครงข่ายอินเทอร์เน็ต 

          Internet of Things หรือ IoT เป็นกรอบแนวคิดของระบบโครงข่ายที ่รองรับการ

เชื่อมต่อกับอุปกรณ์หลากหลายชนิด ตั้งแต่ คอมพิวเตอร์ โทรศัพท์เคลื่อนที่ อุปกรณ์โครงข่าย อุปกรณ์

อิเล็กทรอนิกส์ เซนเซอร์ และวัตถุต่าง ๆ เข้าด้วยกัน อันเป็นผลให้ระบบต่าง ๆ สามารถติดต่อสื่อสารและ

ทำงานร่วมกันได้อย่างเป็นอัตโนมัติทั ้งยังเป็นผลให้มนุษย์สามารถเข้าถึงข้อมูลได้หลากหลายยิ่งขึ้น 

ควบคุมอุปกรณ์และระบบต่าง ๆ ได้อย่างมีประสิทธิภาพมากขึ ้น (สำนักงานคณะกรรมการกิจการ

กระจายเสียง กิจการโทรทัศน์ และกิจการโทรคมนาคมแห่งชาติ, 2561) 

IoT อาจถือเป็นแนวคิดใหม่ที่มีการกล่าวถึงไม่นานมานี้ แต่ IoT เป็นผลสืบเนื่องของการ

พัฒนาระบบอินเทอร์เน็ต ซึ่งมีวัตถุประสงค์เพื่อการสร้างโครงข่ายเพื่อเชื่อมโยงอุปกรณ์ที่มีมาต รฐาน

แตกต่างกันให้สามารถสื่อสารกันได้ โดย IoT จะเปิดโอกาสให้มีการเชื่อมต่อในรูปแบบที่หลากหลายมาก
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ยิ่งขึ้น และรองรับอุปกรณ์ที่พัฒนาโดยผู้ผลิตที่มีเทคโนโลยีแตกต่างกันมากกว่าเดิม ในปัจจุบันสามารถจัด

กลุ่มการเชื่อมต่ออุปกรณ์ต่าง ๆ เข้ากับโครงข่ายอินเทอร์เน็ต ได้ตามรูปแบบดังต่อไปนี้  

2.1.3.1 การเชื ่อมต่อผ่านอุปกรณ์ส ื ่อสารระยะสั้ น (Short-Range Devices) เป็น

รูปแบบการเชื่อมต่ออุปกรณ์ในระยะสั้นมากโดยใช้กำลังส่งต่ำมาก เหมาะสำหรับการสื่อสารในพื้นที่

ครอบคลุมขนาดเล็ก ซึ่งอยู่ในลักษณะการเชื่อมต่อระหว่างอุปกรณ์ (Peer-to-peer) หรือการเชื่อมต่อ

แบบโครงข่ายก็ได้ ตัวอย่างของการเชื่อมต่อในลักษณะดังกล่าว เช่น WiFi, Bluetooth, Z-Wave และ 

ZigBee เป็นต้น 

2.1.3.2 การเชื่อมต่อผ่านโครงข่ายโทรศัพท์เคลื่อนที่ เป็นรูปแบบการให้บริการที่มีพ้ืนที่

ครอบคลุมกว้าง โดยอาศัยการเชื่อมต่ออุปกรณ์เครื่องลูกข่าย IoT เข้ากับโครงสร้างพื้นฐานของระบบ

โทรศัพท์เคลื่อนที่ที่มีอยู่แล้ว ตัวอย่างของการเชื่อมต่อในลักษณะดังกล่าว เช่น เทคโนโลยี NB-IoT และ 

LTE-M เป็นต้น 

2.1.3.3 การเชื่อมต่อผ่านโครงข่าย LPWAN เป็นรูปแบบการเชื่อมต่อผ่านโครงข่าย

กำลังส่งต่ำบริเวณกว้างLow Power Wide Area Network (LPWAN) โดยเน้นใช้งานในลักษณะการ

สื่อสารแบบ NarrowBand หรือ Ultra Narrow Band ที่มีอัตราการส่งข้อมูลต่ำมาก ประหยัดพลังงาน

มาก และมีราคาอุปกรณ์ต่อหน่วยที ่ตัวอย่างของการเชื ่อมต่อในลักษณะดังกล่าว เช่น LoRaWAN, 

SigFox และIngenu เป็นต้น 

   2.1.3.4 การเชื ่อมต่อผ่านโครงข่ายสื ่อสารดาวเทียม เป็นรูปแบบการเชื ่อมต่อที่

เหมาะสมกับการใช้งานที่มีพ้ืนที ่ครอบคลุมการให้บริการที ่กว้างมาก แต่การเชื่อมต่อดังกล่าวจะมี

ระยะเวลาการตอบสนอง (Latency) ช้ากว่าการเชื่อมต่อรูปแบบอื่น ๆ เนื่องจากระยะเวลาที่สัญญาณ

เดินทางไป-กลับ ระหว่างอุปกรณ์สื่อสารภาคพ้ืนโลกและดาวเทียม    

2.1.4 การประยุกต์ใช้งาน Internet of Things  

ความสามารถในการเชื่อมต่ออุปกรณ์ที่หลากหลายเข้ากับโครงข่ายอินเทอร์เน็ตเปิด

โอกาสให้มีการประยุกต์ใช้งานที่หลากหลายและกว้างขวางมาก โดยรูปแบบการเชื ่อมต่ออุปกรณ์

เซนเซอร์ต่าง ๆ จำนวนมากเข้ากับโครงข่าย จะช่วยให้สามารถตรวจวัดข้อมูลที่หลากหลายประเภทได้

เป็นจำนวนมาก และช่วยให้สามารถนำข้อมูลเหล่านั้นมาวิเคราะห์และแสดงผลแบบกราฟฟิกเพื่อช่วยใน

การตัดสินใจได้เมื่อนำระบบดังกล่าวผนวกเข้ากับระบบ Big Data จะช่วยให้สามารถวิเคราะห์ข้อมูลที่มี
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ความซับซ้อน มีจำนวนมากและทันเหตุการณ์ (Real-time)ตัวอย่างของการประยุกต์ใช้งาน Internet of 

Things มีดังต่อไปนี้  

2.1.4.1 การเกษตรแม่นยำ (Precision Farming) 

การเกษตรแม่นยำอาศัยการทำงานร่วมกันของระบบเซนเซอร์ที่วัดความชื้น 

ปริมาณแสงแดด อุณหภูมิระบบฐานข้อมูลพืช และระบบให้น้ำ ปรับปริมาณแสง และระบบปรับอุณหภูมิ 

ที่ทำงานสอดคล้องกันเพื่อสร้างสภาวะแวดล้อมที่เหมาะสมต่อการเจริญเติบโตของพืชมากที่สุด และ

แม่นยำที่สุด ระบบดังกล่าวนอกจากจะช่วยให้เกษตรกรประหยัดและใช้ทรัพยากรเท่าที่จำเป็น ยังช่วยให้

เกษตรกรสามารถประมาณการช่วงเวลาเก็บเกี ่ยวและปริมาณพืชผลที่จะผลิตได้  การรวบรวมและ

ประมวลผลปริมาณความชื้นในพื้นที่เพาะปลูกที่เก็บจากโครงข่ายของเซนเซอร์ในระบบ Precisiona 

Farming ที่ช่วยเฝ้าระวังความชื้นและความแห้งแล้ง โดยพื้นที่สีฟ้าแสดงพื้นที่ที่มีความชื้นสูง พ้ืนที่สีเขียว

แสดงพื้นที่ที่มีความชื้นต่ำซึ่งการแสดงผลดังกล่าวจะช่วยให้เกษตรกรสามารถตัดสินใจในการควบคุม

ปริมาณนำ้ได้ดขีึ้น 

2.1.4.2 อินเทอร์เน็ตอุตสาหกรรม (Industrial Internet) 

อินเทอร์เน็ตอุตสาหกรรม คือ โครงข่ายข้อมูลขนาดใหญ่ที่เชื่อมต่ออุปกรณ์ 

เครื่องจักร เครื่องวัด และระบบการควบคุมในระบบอุตสาหกรรมเข้าด้วยกัน การส่งข้อมูลผ่านโครงขา่ย

จะช่วยให้อุปกรณ์และระบบต่าง ๆ มีการทำงานที่แม่นยำสามารถทำงานสอดคล้องกันได้โดยไม่ต้องใช้

แรงงานคน การเก็บข้อมูลเกี่ยวกับสภาพของเครื่องจักรเช่น อุณหภูมิ การสั่น การหมุน นอกจากจะช่วย

ตรวจสอบความผิดปรกติของเครื่องจักรแล้ว ยังช่วยคาดการณ์เวลาที่จำเป็นต้องเปลี่ยนอะไหล่ของ

อุปกรณ์เมื่อชำรุด ซึ่งจะช่วยลดค่าใช้จ่ายในการเปลี่ยนอะไหล่ใหม่ที่ไม่จำเป็น นอกจากนี้การเชื่อมต่อ

ข้อมูลระหว่างร้านสะดวกซื้อระบบโลจิสติกส์ และโรงงาน จะช่วยให้สามารถบริหารการผลิตและกระจาย

สินค้าให้มีประสิทธิภาพมากขึ้นซึ่งประเทศไทยในฐานะที่มีสัดส่วนการผลิตในภาคอุตสาหกรรมอยู่ใน

ระดับสูง จะมีโอกาสได้ประโยชน์จากการเพิ่มประสิทธิภาพการผลิตและลดต้นทุนที่ไม่จำเป็น 

2.1.4.3 ระบบขนส่งและยานพาหนะ (Logistics and Vehicles) 

โครงข่าย IoT จะเข้ามามีส่วนช่วยในการพัฒนาระบบคมนาคมและการ

จัดการโลจิสติกส์โดยช่วยสนับสนุนให้มีการเชื่อมต่อข้อมูลระหว่างยานพาหนะด้วยกัน หรือระหว่าง

ยานพาหนะและระบบควบคุมการจราจรอ่ืน เช่น ระบบสัญญาณจราจร ระบบข้อมูลสภาพจราจร ซึ่งการ
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นำเอาระบบดังกล่าวมาใช้กับระบบขนส่งมวลชนที่จะช่วยให้การบริการมีความปลอดภัย สะดวก แม่นยำ

และตรงเวลามากยิ่งขึ้น นอกจากนี้ การนำระบบดังกล่าวไปใช้ในการขนส่งสินค้าจะทำให้สามารถทราบ

ตำแหน่งยานพาหนะ ทราบสถานการณ์รับ-ส่งสินค้า อันส่งผลให้การจัดการสินค้าคงคลังมีประสิทธิภาพ

มากยิ่งขึ้นตัวอย่างของการใช้งานระบบติดตามยานพาหนะในประเทศไทย 

2.1.4.4 ระบบการจัดการเมืองและสาธารณูปโภค (Smart City and Utilities) 

ระบบการจัดการเมืองและสาธารณูปโภคที ่มีประสิทธิภาพจะต้องมีการ

ตรวจวัดที่แม่นยำการประมวลผลในภาพรวม และการประมาณการที่มีความเชื่อถือได้ ระบบ IoT จะถูก

นำมาประยุกต์ใช้ในการรวบรวมข้อมูลที่สำคัญต่าง ๆ ภายในเมือง ซึ่งจะช่วยให้ภาครัฐสามารถวางแผน 

และเข้าไปให้บริการประชาชน ได้อย่างรวดเร ็วและมีประสิทธิภาพ เช ่น การใช้พลังงานและ

สาธารณูปโภค การบริหารจัดการพลังงานไฟฟ้าโดยใช้ระบบโครงข่ายไฟฟ้าอัจฉริยะ (Smart grid) ที่ทำ

หน้าที ่ตรวจวัดปริมาณการใช้งานพลังงานไฟฟ้า และรวบรวมข้อมูลเพื ่อประมาณการค่าอุปสงค์ 

(Demand forecast) การใช้ไฟฟ้าในช่วงเวลาต่าง ๆ อันจะเป็นประโยชน์ต่อการควบคุมการจ่ายไฟฟ้า 

การวางแผนสร้างโรงไฟฟ้า จัดการแหล่งจ่ายพลังงานไฟฟ้า และการคิดราคาค่าไฟฟ้าแบบสอดคล้องกับ

ค่าอุปสงค์-อุปทาน สภาพการจราจร ความปลอดภัย การบริการสาธารณะ (Public service) ซึ่งจะช่วย

ให้เมืองสามารถบริหารจัดการทรัพยากรให้ตรงตามความต้องการและชีวิตความเป็นอยู่ของคนในท้องที่

การวัดสถานะระดับน้ำเพ่ือการบริหารจัดการการระบายน้ำ แผนที่ค่าการวัดมลภาวะ และสถานะปริมาณ

ขยะเพ่ือการจัดเก็บ เป็นต้น 

2.1.4.5 ระบบสาธารณสุข (Smart Health/Human) 

การประยุกต์ใช้เทคโนโลยี IoT เพ่ือระบบสาธารณสุขอัจฉริยะสามารถทำได้

โดยการใช้อุปกรณ์ IoT ที่เก็บข้อมูลสุขภาพ หรือการใช้อุปกรณ์สวมใส่ (Wearable devices) เพื่อวัด

สัญญาณทางร่างกาย (Bio signals) เช่นชีพจร ความดันโลหิต คุณภาพการนอน การเคลื่อนที่ และการ

หายใจ เป็นต้น เพื่อรวบรวมและประมวลผลข้อมูลด้านสุขภาพเบื้องต้น รวมถึงการคาดการณ์และการ

วินิจฉัยการเจ็บป่วยล่วงหน้า (Predictive diagnostic)การแจ้งเตือนการเจ็บป่วยทันที และระบบติดตาม

การแพร่กระจายของโรค ซึ่งข้อมูลสถิติการเจ็บป่วยและสุขภาพของประชาชนโดยรวมจะเป็นประโยชน์

ต่อการวางนโยบายด้านสาธารณสุข 

2.1.4.6 ระบบค้าปลีกและเทคโนโลยีการเงิน (Retail Environment)  
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เทคโนโลยี IoT สามารถเข้ามามีบทบาทสนับสนุนระบบค้าปลีกและเทคโนโลยี

ทางการเงินได้หลายรูปแบบเช่น ระบบการชำระเงินอัตโนมัติ (Auto-payment) ในร้านค้าปลีก ระบบ

การชำระเงินโดยผ่าน Wearable devices และโทรศัพท์เคลื่อนที ่ การบริหารจัดการสินค้าคงคลัง 

รวมถึงสามารถทำงานร่วมกับอุปกรณ์อื่น ๆ เช่น ในโรงงานอุตสาหกรรม ในงานเกษตรกรรม เพื่อสั่งซื้อ

และชำระเงินค่าวัสดุอุปกรณ์และวัตถุดิบโดยอัตโนมัตินอกจากนี้ ระบบค้าปลีกและเทคโนโลยีการเงินยัง

สามารถช่วยสนับสนุนการสร้างคุณค่าและเพ่ิมประสิทธิภาพการผลิตและการให้บริการในภาคส่วนอ่ืน 

เช่น การท่องเที่ยว ค้าปลีก และการจัดการข้อมูลกลางภาครัฐ เป็นต้น 

2.1.4.7 ระบบการจัดการในบ้าน (Smart Home)  

เทคโนโลยี IoT จะเข้ามามีบทบาทมากขึ้นเรื่อย ๆ ในการใช้ชีวิตประจำวัน

ภายในที่อยู ่อาศัย โดยอุปกรณ์เครื ่องใช้ต่าง ๆ จะสามารถเชื ่อมต่อกับอินเทอร์เน็ตได้ เช่น ตู ้เย็น 

เครื่องปรับอากาศ หลอดไฟ เครื่องเสียง กลอนประตูไฟฟ้า ระบบความปลอดภัยภายในบ้าน เครื่องซักผ้า 

หรือแม้กระทั่งแปรงสีฟัน เราจะสามารถควบคุมระบบต่าง ๆ ภายในบ้านได้ผ่านอินเทอร์เน็ต ซึ่งจะส่งผล

ให้ประสบการณ์การใช้ชีวิตของเราเปลี่ยนไป เช่น ในอนาคตบ้านจะสามารถรับรู้ได้ว่าเรากำลังจะกลับถึง

บ้าน หรือออกจากบ้านไปแล้ว และสามารถควบคุมเครื่องใช้ไฟฟ้าต่าง  ๆ ได้โดยอัตโนมัติ เช่น เปิดปิด

เครื่องปรับอากาศ หรือเปิดปิดไฟ ซึ่งการใช้งาน IoT ภายในบ้านในรูปแบบใหม่ ๆ ดังกล่าว จะสามารถ

ช่วยให้เราจัดการชีวิตได้ง่ายมากขึ้นโดยเฉพาะการลดเวลาในการทำงานบ้าน รวมถึงอาจมีประโยชน์ใน

ด้านการประหยัดพลังงานและการรักษาความปลอดภัยที่ดีขึ้น 

2.1.4.8 ระบบการจัดการสำนักงาน (Smart Office) 

ระบบการจัดการสำนักงานเป็นส่วนหนึ่งที่ IoT จะเข้ามามีบทบาท โดยเฉพาะ

ด้านการบริหารจัดการการใช้พลังงานและการดูแลรักษาความปลอดภัยภายในสำนักงาน โดยสถาบันวิจัย 

McKinsey Global ได้ประเมินว่า การใช้อุปกรณ์ IoT ในสำนักงานจะช่วยให้บริษัทสามารถประหยัด

พลังงานได้ถึง 20 เปอร์เซ็นต์นอกจากนี้บริษัทและหน่วยงานต่าง ๆ สามารถประยุกต์ใช้ IoT ในการเพ่ิม

ขีดความสามารถในการทำงาน (Productivity) ของพนักงานในบริษัท ไม่ว่าจะเป็น การอบรมพนักงาน

ใหม่ด้วยระบบ Virtual reality การจัดการและติดตามเอกสาร รวมถึงการติดตามการทำงานของ

พนักงานเพื่อพัฒนาระบบการทำงานให้มีประสิทธิภาพยิ่งขึ้น การเข้ามาของอุปกรณ์ IoT จะสามารถทำ
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ให้บริษัทและหน่วยงานต่าง ๆ ใช้คนน้อยลง แต่ในขณะเดียวกันได้งานมากขึ้น ลดต้นทุน และเพ่ิมโอกาส

ในการเติบโต         

 2.2 ยา (Drug)   

2.2.1 ความหมายและความสำคัญ 
ยาเป็นปัจจัยพื้นฐานสำหรับมนุษย์ ใช้บรรเทาความเจ็บป่วยบำบัดหรือตรวจวินิจฉัยโรค 

ซึ่งอาจจะได้มาจากการสังเคราะห์ หรือจากแหล่งธรรมชาติก็ได้ ความรู้ความเข้าใจที่ถูกต้องเก่ียวกับยาจะ
มีส่วนช่วยให้การใช้ยาเป็นไปอย่างปลอดภัย (สถานพยาบาลมหาวิทยาลัยเกษตรศาสตร์ ,2551) 

 
2.2.2 ประเภทของยา  
กฎหมาย ได้กำหนดมาตรการต่าง ๆ และการแบ่งประเภทตามการควบคุมกำกับเพ่ือ

คุ ้มครองผู้บริโภค ให้ได้ร ับความปลอดภัยจากการใช้ยาแก่ผู ้บริโภคไว้ด ังนี้ (คณะแพทย์ศาสตร์
มหาวิทยาลัยมหิดล, มปป) 

2.2.2.1 ยาสามัญประจำบ้าน  
ยาในกลุ่มนี้เป็นยาที่ได้รับการพิจารณาแล้วว่าปลอดภัย โอกาสเป็นอันตรายต่อ

สุขภาพน้อย กฎหมายจึงอนุญาตให้วางจำหน่ายได้ทั่วไป และให้ผู้ป่วยสามารถตัดสินใจเลือกใช้ยาด้วย
ตนเองตามอาการเจ็บป่วยเบื้องต้น ตัวอย่างยาในกลุ่มนี้ เช่น ยาเม็ดบรรเทาปวดลดไข้พาราเซตตามอล 
500 มิลลิกรัม(เฉพาะขนาดบรรจุ 4 และ 10เม็ด) ยาเม็ดแก้แพ้ลดน้ ำมูกคลอร์เฟนิรามีน 2 มิลลิกรัม
(ขนาดบรรจุ 4 และ 10 เม็ด) เป็นต้น 

2.2.2.2 ยาอันตราย  
เป็นยาที่กฎหมายอนุญาตให้ขาย ได้เฉพาะในร้านขายยา แผนปัจจุบัน เท่านั้น

และต้องอยู่ภายใต้ การควบคุมของเภสัชกรผู้มีหน้าที่ปฏิบัติการไม่ ว่าจะการจัดทำบัญชีซื้อ บัญชีขาย 
การควบคุมการจัดเก็บยาตลอดถึงการส่งมอบยาพร้อม คำแนะนำที่เหมาะสมแก่ผู้ป่วย ทั้งนี้เนื่องจากยา 
ในกลุ่มนี้อาจก่อให้เกิดอันตรายได้ง่ายหากใช้ไม่ ถูกต้องยาในกลุ่มนี้สังเกตได้จาก “อักษรสีแดง” ที่ระบุว่า 
“ยาอันตราย” บริเวณกล่อง หรือ ภาชนะบรรจุยาตัวอย่างยาในกลุ่มนี้ เช่น ยา ปฏิชีวนะ ยาเบาหวาน ยา
แก้ปวดชนิดต่าง ๆ 
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2.2.2.3 ยาควบคุมพิเศษ  
เป็นยาที่ผู้ป่วยจะใช้ยานี้ได้ก็ต่อเมื่อได้รับการวินิจฉัยจากแพทย์ก่อนกล่าวคือ 

จะซื้อยาในกลุ่มนี้จากร้านขายยาแผนปัจจุบันได้ก็ต่อเมื่อมีใบสั่งยาแพทย์เท่านั้น และเภสัชกรจะต้องเป็น
ผู้ควบคุมการทา บัญชี และเป็นผู้ส่งมอบยาพร้อมให้คา แนะนำทีเ่หมาะสมด้วย ยาในกลุ่มนี้สังเกตได้จาก 
“อักษรสีแดง” ที่ระบุว่า “ยาควบคุมพิเศษ” บริเวณกล่อง หรือภาชนะบรรจุยา ตัวอย่างยาในกลุ่มนี้เช่น 
ยาเม็ดสเตียรอยด์เนื่องจากมียาควบคุมพิเศษบางรายการที่อาจก่อให้เกิดอันตรายจากการใช้ยาได้สูง จึง
จา เป็นต้องอยู่ภายใต้การควบคุมดูแลจากแพทย์ผู้เชี่ยวชาญอย่างใกล้ชิด ยาควบคุมพิเศษดังกล่าวจึงถูก
จา กัดการใช้ให้อยู่ในสถานพยาบาล หรือโรงพยาบาล เท่านั้น และยังได้กำหนดให้ผู้รับอนุญาตนำหรือสั่ง
ยาเข้ามาในราชอาณาจักรต้องจัดทำบัญชีรายชื ่อยาที ่ผลิตหรือนำหรือสั ่งฯ รายงานให้สำนักงาน
คณะกรรมการอาหารและยาทราบทุก 4 เดือนตัวอย่างยาในกลุ่มนี้เช่น ยารักษาสิวกลุ่มเรตินอยด์ ยากลุ่ม
ที่ใช้ในการรักษาภาวะเสื่อมสมรรถภาพทางเพศ เป็นต้น 

 
2.2.3 ยาฉุกเฉินและยาที่ให้ทันที 
การจัดการยาฉุกเฉินเป็นการเตรียมความพร้อมในการให้ยาแก่ผู้ป่วยทันทีเพื่อช่วยชีวิต 

หรือ ยาที่ต้องให้ทันทีเพื่อลดความเสี่ยงต่อการเสียชีวิตของผู้ป่วย หรือยาที่ใช้บรรเทาอาการสำคัญของ
ผู้ป่วย การจัดการยากลุ่มนี้พิจารณาจากความจำเป็นที่ผู้ป่วยต้องได้รับยาภายในระยะเวลาที่กำหนด 
ความเสี่ยงต่อการเกิดความคลาดเคลื่อนทางยา โดยเฉพาะยาที่มีความเสี่ยงสูง รวมถึง ข้อจำกัดด้าน
ระยะทางระหว่างห้องบริการจ่ายยากับหอผู้ป่วย (รัชฎาพร สุนทรภาส และศมน อนุตรชัชวาล, 2559)  

   2.2.3.1 ยาฉุกเฉิน (Emergency Drug) 

ยาฉุกเฉิน หมายถึง ยาที่ใช้ในการช่วยชีวิตผู้ป่วยที่มีภาวะระบบหัวใจ และ

หลอดเลือดล้มเหลว มีอาการแพ้ยาอย่างรุนแรง มีอาการชัก หรือมีภาวะหลอดลมหดเกร็ง ผู้ป่วยต้อง

ได้รับยาทันทีหลังมีคำสั่งใช้ยา หากไม่ได้รับยาอย่างทันท่วงที อาจทำให้ผู้ป่วยเสียชีวิต 

2.2.3.2 ยาที่ให้ทันที (Stat Drug) 

หมายถึง ยาที่ให้แก่ผู้ป่วยที่จำเป็นต้องได้รับการรักษาอย่างเร่งด่วน แต่ไม่ใช่ยา

ฉุกเฉิน (Emergency drug) หากผู้ป่วยไม่ได้รับยา จะเพิ่มความเสี่ยงต่อการเสียชีวิตของผู้ป่วย แบ่ง

ออกเป็น 2 ระดับความเร่งด่วน คือ ยา Stat ที่ผู้ป่วยต้องได้รับภายใน 5 นาที และยา Stat ที่ผู้ป่วยต้อง

ได้รับภายใน 15 นาที 
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3. งานวิจัยที่เกี่ยวข้อง 

        คณะผู้จัดทำได้รวบรวมข้อมูลงานวิจัยที่เกี่ยวข้องโครงงานการศึกษาระบบต้นแบบการแจ้งเตือนยา
STAT แผนกเภสัชกรรมโรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี ไว้ดังนี้ 

เสฏ ณวุฒิและวิมาร (2560) ได้ศึกษาวิจัยเรื่องการพัฒนาระบบแจ้งเตือนการเกิดอัคคีภัยผ่าน
แอพพลิเคชันไลน์ด้วยเทคโนโลยีอินเทอรเน็ต ของสรรพสิ่ง พบว่าอุปกรณ์สามารถตรวจวัดอุณหภูมิควัน 
และความชื้นไดถูกต้องแม่นยำ การรับส่งข้อมูลกับอันโตสามารถรับและส่งข้อมูลระหว่างกันไดตลอดเวลา 
และการส่งข้อความแจ้งเตือนไปยังแอพพลิเคชันไลนเป็นไปตามเงื่อนไขท่ีกำหนด 

ผลการพัฒนาเว็บแอพพลิเคชัน ผู้ใช้สามารถเข้าสูระบบ ตั้งค่าและเรียกดูอุณหภูมิ ควัน และ
ความชื้นได และการดำเนินงานในส่วนของของเซิร์ฟเวอรอันโตสามารถสื่อสารข้อมูลไดอย่างรวดเร็ว 
ไมติดขัดแต่อย่างใดใดการทำงานในภาพรวมของระบบ สวนประกอบต่าง ๆสามารถทำงานร่วมกันได
อย่างดี การ ส่งข้อมูลระหว่างกันกันไมพบข้อผิดพลาดพลาดใด ๆ 
        สกุล คำนวนชัยและชม กิ้มปาน (2560) ได้ศึกษาวิจัยเรื่องอินเทอร์เน็ตออฟติง การรดน้ำในแปลง

ผักชีพร้อมแจ้งเตือนผ่านไลน์แอพพลิเคชั่น  ให้สามารถนำไปใช้งานกับเกษตรกรได้จริง โดยระบบมี

ขั้นตอนทำงานแบ่งออกเป็น 2 ส่วน ดังนี้ 1) กำหนดเวลาการทำงานในสภาพอากาศปกติ ระบบมีตาราง

การทำงานวันละ 3 ครั้ง แต่ละครั้งทำงานได้ตั ้งแต่ 1-60 นาที      2) การส่งข้อความแจ้งเตือนไปยัง

เกษตรกร โดยระบบสามารถกำหนดเครื่องปลายทางที่ต้องรับข้อความได้หนึ่งบัญชีสมาชิก Line โดย

ระบบของ Line Notify ด้วยข้อความในการสื่อสารโดยใช้ข้อความแจ้งเตือนว่า “ IOT ผักชี: ตามด้วย

ข้อความ สถานการณ์ทำงานของการรดน้ำผักชี” และในสภาพอากาศที่มีฝนตกมีอุปกรณ์ตรวจจับสภาพ

ความชื ้นส ัมพัทธ ์ท ี ่ม ีค ่าต ั ้งแต่    90% ข ึ ้นไป ซ ึ ่งเป ็นค่าความชื ้นส ัมพัทธ ์ว ่าม ีฝนตก ระบบมี

โปรแกรมควบคุมเวลาในการรดน้ำหลังจากฝนตก 30 นาที ให้มีการ รดน้ำเพิ่มเติมอีก 20 นาที เพื่อล้าง

น้ำฝนที่ค้างใบผักชีออก เป็นการลดความเสียหายของใบผักชีจากใบด่างและเน่า   

        ผลจากการเก็บข้อมูลการทำงานของระบบในการสั่งงานทั้งในสภาพอากาศที่ไม่มีฝนตกและมีฝน

ตก และการแจ้งเตือนผ่าน ทางไลน์แอพพลิเคชั่นจำนวน 20 วัน ๆ ละ 3 ครั้ง รวมเป็นจำนวน 60 ครั้ง 

ระบบมคีวามถูกต้องในการทำงานคิดเป็นร้อยละ 96.66  

 

  



บทที่ 3 

วิธีดำเนินโครงการการปฏิบัติงาน 
 

        จากการได้รับมอบหมายจากแผนกเภสัชกรรมในการคิดค้นระบบการชั่งยา  Stat นั้น คณะผู้จัดทำ 

มีความต้องการในการศึกษาและพัฒนาระบบขึ้นเพ่ือให้เป็นประโยชน์ต่อแผนกเภสัชกรรมและโรงพยาบาล

มหาวิทยาลัยเทคโนโลยีสุรนารี โดยดำเนินตามขั้นตอนดังนี้ 

1. ข้ันตอนการดำเนินโครงการ 

ในการพัฒนาระบบต้นแบบการแจ้งเตือนยา Stat แผนกเภสัชกรรม โรงพยาบาลมหาวิทยาลัย

เทคโนโลยีสุรนารีผู้จัดทำมีข้ันตอนในการดำเนินงานอยู่ 3 ขั้นตอน ดังนี้ 

ขั้นตอนที่ 1 กำหนดระยะเวลาในการดำเนินโครงการและสอบถามข้อมูลและเก็บรวบรวม

ข้อมูลการตรวจเช็คยาของแผนกเภสัชกรรม 

ตารางที่ 3.1 ตารางแสดงระยะเวลาการดำเนินโครงการ 

ขั้นตอน 

ระยะเวลา 

2562 2563 

พฤศจิกายน ธันวาคม มกราคม กุมภาพันธ์ 

ศึกษาการใช้งานและ

ข้อมูลบอร์ด Arduino 

กับ Sensor  

                            

ศึกษาการใช้งานและ

ข้อมูลบอร์ด Arduino 

กับ Line Notify 

                            

ศึกษาการใช้งานและ

ข้อมูลบอร์ด Arduino 

กับFirebase 
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ตารางท่ี 3.1 ตารางแสดงระยะเวลาการดำเนินโครงการ (ต่อ) 

ขั้นตอน 

ระยะเวลา 

2562 2563 

พฤศจิกายน  ธันวาคม มกราคม กุมภาพันธ์ 

ทำบอร์ด Arduino ให้

ชั่งน้ำหนักได้และแจ้ง

เตือนผ่าน Line และ

ไฟ LED 

                            

ทดสอบการทำงาน

ครั้งที่ 1 

                            

แก้ไขข้อผิดพลาดและ

เพ่ิมเติมส่วนที่ต้องการ 

                            

ทดสอบการทำงาน

ครั้งที่ 2 

                            

 

ขั้นตอนที่ 2 ประกอบอุปกรณ์และเชื ่อมต่ออุปกรณ์เข้ากับระบบเครือข่ายอินเตอร์เน็ต

Firebase และ Line Notify 

 
ภาพที่ 3.1  การประกอบอุปกรณ์ 

 



20 
 

 
  

 
ภาพที่ 3.2  การเชื่อมต่อฐานข้อมูล 

 ขั้นตอนที่ 3 Coding การทำงานของเครื่องและทดสอบการทำงานของโปรแกรมและอุปกรณ์

ชั่งยาให้ประมวลผลได้ 

  
ภาพที่ 3.3 การCoding 
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2. กรอบแนวคิดการพัฒนาโครงการ 

        การพัฒนาระบบต้นแบบการแจ้งเตือนยา Stat แผนกเภสัชกรรม โรงพยาบาลมหาวิทยาลับ

เทคโนโลยีสุรนารี คณะจัดทำมีความต้องให้ผู้ ใช้งานระบบสามารถใช้งานได้อย่างมีประสิทธิภาพแต่เนื่อง

ด้วยขึ้นตอนหลายอย่างอาจไม่เสถียรพอในการใช้งานจริงคณะผู้จัดทำจึงพัฒนาให้ระบบใช้งานเสมือนจริง

ที่สุด ดังนี้ 

User จะต้องทำการเชื่อมต่ออินเทอร์เน็ตใช้บอร์ดอาดูโน่ในการชั่งน้ำหนักผ่านตัว Sensor Load 

cell และเครื่องจะทำงานชั่งน้ำหนักยาและทำการตรวจสอบเงื่อนไขว่าต่ำกว่าเกณฑ์ท่ีกำหนดหรือไม่ หาก

น้ำหนักต่ำกว่าเกณฑ์เครื่องจำทำการแจ้งเตือนไปที่ไลน์ และไฟ LED จะติดที่กระบะเก็บยา และจะมีการ

เก็บข้อมูลจำนวนยาลง Database และทำการแจ้งเตือนไปยัง Line Notify ของ User โดยมีกระบวนการ

ทำงานดังภาพที่ 3.1 และ 3.2 

 
 

ภาพที่ 3.4  กระบวนการทำงานของระบบการแจ้งเตือนยา Stat 

กระบวนการทำงานของระบบการแจ้งเตือนยา Stat ในรูปแบบกราฟิกเพ่ือให้เข้าใจง่านยิ่งขึ้น 
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ภาพที่ 3.5 Flow chart ขั้นตอนการทำงาน 

กระบวนการทำงานของระบบการแจ้งเตือนยา Statต้ังแต่การเชื่อมต่ออินเทอร์เน็ต , Data Base 

, Line Notify การชั่งยา และประมวลผล  
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 3. เครื่องมือที่ใช้ในการดำเนินโครงการ 

3.1 โปรแกรม Arduino IDE 

 
ภาพที่ 3.6 โปรแกรม Arduino IDE 

3.1.1 ส่วนที่เป็นฮาร์ดแวร์ (Hardware) 

บอร์ดอิเล็กทรอนิกส์ขนาดเล็ก ที่มีไมโครคอนโทรลเลอร์ (MCU) เป็นชิ้นส่วนหลัก ถูกนำมาประกอบ

ร่วมกับอุปกรณ์อิเล็กทรอนิกส์อ่ืน ๆ เพ่ือให้ง่ายต่อการใช้งาน หรือที่เรียกกันว่า บอร์ด Arduino, โดย

บอร์ด Arduino เองก็มีหลายรุ่นให้เลือกใช้ โดยในแต่ละรุ่นอาจมีความแตกต่างกันในเรื่องของขนาดของ

บอร์ด หรือสเปค เช่น จำนวนของขารับส่งสัญญาณ, แรงดันไฟที่ใช้, ประสิทธิภาพของ MCU เป็นต้น 

(สามารถเปรียบเทียบ และดูสเปคคร่าว ๆ ของ Arduino 

3.1.2 ส่วนที่เป็นซอฟต์แวร์ (Software) 

ภาษา Arduino (ซึ่งจริง ๆ แล้วก็คือ ภาษา C/C++) ใช้สำหรับเขียนโปรแกรมควบคุม MCUArduino ถูก

ใช้ประโยชน์ในลักษณะเดียวกับ MCU คือ ใช้ติดต่อสื่อสารและควบคุมอุปกรณ์ไฟฟ้าอื่น ๆ ด้วยการเขียน

โปรแกรมให้กับ MCU เพ่ือควบคุมการรับส่งสัญญาณทางไฟฟ้าตามเงื่อนไขต่าง ๆตัวอย่าง การประยุกต์ใช้ 

Arduino ในชีวิตประจำวัน เช่น ระบบเปิด/ปิดไฟในบ้านอัตโนมัติ, ระบบรดน้ำต้นไม้อัตโนมัต,ิ ระบบเปิด/

ปิดประตูอัตโนมัต,ิ ระบบเครื่องซักผ้าหยอดเหรียญ หรือ ใช้ควบคุมความเร็ว และทิศทางการหมุนของคุม

มอเตอร์ เป็นต้นArduino IDE เป็นเครื ่องมือสำหรับเขียนโปรแกรมด้วยภาษา Arduino, คอมไพล์

โปรแกรม (Compile) และอัพโหลดโปรแกรมลงบอร์ด (Upload) (PoundXI , 2559) 
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3.2 โปรแกรม Firebase 

 
ภาพที่ 3.7 โปรแกรม Firebase 

Firebase คือระบบโครงสร้างพื ้นฐานที ่จำเป็นสำหรับการพัฒนาแอพพลิเคชั ่น โดยที ่ตัว 

Firebase เองถูกออกแบบมาให้สามารถทำงานได้ในหลากหลาย Platform ทั ้ง Web Application, 

Mobile Appslication ที่สามารถใช้งานได้ทั้งในระบบปฏิบัติการ iOS และระบบปฏิบัติการ Android 

โดยทั ่วไปแล้ว โครงสร ้างพื ้นฐานที ่จำเป ็นในการพัฒนาแอพพล ิเคช ั ่น ( Application 

Infrastructure ) จำเป็นจะต้องมีอะไร Firebase ถูกออกแบบมาเพื่อสิ่งนั้น และเตรียมโครงสร้างนั้นให้

นักพัฒนาสามารถนำไปใช้งานโดยไม่ต้องพัฒนาโครงสร้างนั้น ๆ ขึ ้นมาใหม่ทุกครั ้ง ตัวอย่าง เช่น 

Analytics เก็บสถิติ, Authentication ยืนยันตัวตน, Realtime Database เก็บข้อมูลแบบเรียลไทม์ , 

Cloud Messaging สำหรับการส่งข้อความ และอื่น ๆ อีกมากกมาย เหล่านี้ล้วนเป็นโครงสร้างพื้นฐานที่

จำเป็นในการพัฒนาแอพพลิเคชั่น หากต้องพัฒนาขึ้นมาใหม่ทั้งหมด จำเป็นต้องใช้เวลาในการพัฒนาที่

มากขึ้น รวมไปถึงการพัฒนาต่อยอด ก็จะสามารถพัฒนาต่อยอดได้ง่าย(บริษัทโค๊ดบี จำกัด, 2560) 

3.3 โปรแกรม Visual Studio  

 
ภาพที่ 3.8 โปรแกรม Visual Studio  
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Visual Studio (วิชวลสตูดิโอ) คือ โปรแกรมตัวหนึ่งที่เป็นเครื่องมือที่ช่วยพัฒนาซอฟต์แวร์และระบบต่าง 

ๆ ซึ่งสามารถติดต่อสื่อสารพูดคุยกับคอมพิวเตอร์ได้ในระดับหนึ่งแล้ว แต่ยังไม่สามารถพัฒนาเป็นระบบ

เองได้ เหมาะสมสำหรับภาษา VB และ VB.NET เนื่องจากไมโครซอฟต์ได้พัฒนาโปรแกรมและภาษาขึ้นมา

ควบคู่กันเพื่อให้ใช้งานได้ซึ่งกันและกัน ซึ่งนักโปรแกรมเมอร์จะนำเครื่องมือมาใช้ในการพัฒนาต่อยอดให้

เกิดเป็นระบบต่าง ๆ หรือเป็นเว็บไซต์ และแอพพลิเคชั่นต่าง ๆ (Mindphp , 2559) 

3.4 โปรแกรม diagram draw.io 

 
ภาพที่ 3.9 โปรแกรม diagram draw.io 

Draw.io เป็น Web Application ที่พัฒนาขึ้นโดยใช้เทคโนโลยี mxGraph ซึ่งตัว mxGraph เป็น 

Library ที่พัฒนาด้วยภาษา Javascript สำหรับสร้าง Diagram หรือนำไปประยุกต์สร้างแผนภูมิหรือกราฟ

ต่าง ๆ ได้อย่างรวดเร็ว พัฒนาโดย JGraph Limited กลับมาดูที่ตัว Draw.io ถือเป็นทางเลือกของผู้ที่

ต้องการสร้าง Diagram หรือ Flowchart ต่าง ๆ แต่ไม่อยากลงโปรแกรม Draw.io สามารถใช้งานได้ทันที

ผ่านระบบ Online หรือถ้าหากเคยใช้งานโปรแกรมชื่อดังอย่าง Visio แล้วล่ะก็สามารถใช้ Draw.io เป็น

ทางเลือกใช้งานแทนกันได้ (Mdsoft , 2556) 

 



บทที่ 4 

ผลการดำเนินโครงการการปฏิบัติงาน 
 

ปฏิบัติการทั้งหมดไม่ว่าจะเกี่ยวข้องหรือไม่กับการปฏิบัติงานหลังจากจบฝึกสหกิจศึกษาทำให้เกิด

การเรียนรู้เกี่ยวประสบการณ์จริงการทำงานจริง ผลได้รับ คือความรู้ เทคนิค ต่าง  ๆ การทำงานเป็นทีม 

ทำงานร่วมกับผู ้อื ่นได้เรียนรู ้เกี ่ยวกับระบบการเปรียบเทียบข้อมูลของยาฉุกเฉิ น จัดทำขึ ้นเพ่ือเป็น

ประโยชน์ 

จากผู้จัดทำเข้าฝึกปฏิบัติงานสหกิจศึกษากับแผนกสารสนเทศโรงพยาบาลมหาวิทยาลัย

เทคโนโลยีสุรนารี ที่มุ่งมั่นพัฒนาสร้างสรรค์งานที่มีคุณภาพ ได้พัฒนาระบบต้นแบบการแจ้งเตือนยาฉุกเฉิน 

แผนกเภสัชกรรม โรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี  เพ่ือสนับสนุนการทำงานการเช็คยาแผนก

เภสัชกรรม เพื่อให้มีความสะดวกในการปฏิบัติงานของพนักงานในแผนกเภสัชกรรม  

 

1. ผลการดำเนินงานโครงการ 

โครงการศึกษาระบบต้นแบบการแจ้งเตือนเช็คยา Stat แผนกเภสัชกรรม โรงพยาบาล

มหาวิทยาลัยเทคโนโลยีสุรนารี มีดังนี้  

1. การติดตั้งโปรแกรม Arduino IDE  

คือการติดตั้งโปรแกรมเพ่ือใช้ในการเขียนโปรแกรมให้กับบอร์ด ESP8266 หรือบอร์ดอ่ืน ๆ ผ่าน

ทาง Arduino ใช้ภาษาหลักการของภาษา C++ ครอบด้วยภาษาของ Aruino เพ่ือให้การเขียนโปรแกรมมี

ความง่ายมากยิ่งข้ึน 

 1.1 ดาวน์โหลด Arduino IDE เข้าไปที่หน้าเว็บไซต์ www.arduino.cc/en/Main/Software 

เลือก Windows Installer 
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ภาพที่ 4.1 หน้าต่าง www.arduino.cc 

 
ภาพที่ 4.2 หน้าต่าง www.arduino.cc/en/Main/Softwares 

2. ตั้งค่าโปรแกรมสำหรับ Board WeMos D1 ESP8266 

 2.1 เพ่ิม Additional Board Manager URLs ที่รองรับ ESP8266 ในโปรแกรม Arduino IDE 

เข้าไปที่ File > Preference กรอก URL ด้านล่าง 

 “http://arduino.esp8266.com/stable/package_esp8266com_index.json” 

http://www.arduino.cc/en/Main/Softwares
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ภาพที่ 4.3 การเลือกเข้าไปที่ File > Preference 

 
ภาพที่ 4.4 การกรอกค่าที่รองรับ ESP8266 ใน Additional Board Manager URLs 

2.2 เพิ่ม Board ESP8266 ด้วย Board Manager เลือก Tools > Board: “name” > Boards 
Manager… พ ิมพ ์ท ี ่ ช ่ องค ้นหา "esp8266" แล ้ ว เล ื อก esp8266 by ESP8266 Community กด 
Download   
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ภาพที่ 4.5 การเลือกเข้าไปที่ Tools > Board: “name” > Boards Manager… 

 
ภาพที่ 4.6 การเพ่ิมบอร์ด "esp8266 " กด Download เสร็จสิ้น 

 2.3 เลือกบอร์ดเข้าไปที่ Tools > Board: “name” เลือก “WeMos D1 R1” เพ่ือเป็นการตั่งค่า

ให้โปรแกรมตรงกับบอร์ดที่จะพัฒนา 
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ภาพที่ 4.7 การเลือกบอร์ด Tools > Board: “name” เลอืก “WeMos D1 R1” 

 

3. เขียนโค้ดและค่าคำสั่งลงไปใน Aduino IDE  

โดยสามารถดูโค้ดได้จากลิงค์  “https://github.com/Premsakpa/LoadCell_Suth” 

 
ภาพที่ 4.8 หน้าต่าง https://github.com/Premsakpa/LoadCell_Suth 
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4. การตรวจสอบความถูกต้องของโค้ด 

 4.1   คลิกท่ีเครื่องหมายถูก ตามปุ่มสีเหลืองที่ปรากฏในภาพ  

 
ภาพที่ 4.9 การตรวจสอบความถูกต้องของโค้ด 
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4.2 เมื่อโค้ดถูกต้อง จะแสดงดังภาพ 4.10 

 
ภาพที่ 4.10  การตรวจสอบความถูกต้องของโค้ดเมื่อโค้ดถูกต้องทั้งหมด 
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 4.3 หากมีโค้ดที่ผิดจะแสดงด้านล่างเป็นสีส้ม บอกว่าปัญหาคืออะไร พร้อมแสดงบรรทัดที่ผิดเป็น 

สีแดงดังภาพ 4.11 

 
ภาพที่ 4.11 การตรวจสอบความถูกต้องของโค้ดเมื่อมีโค้ดที่ผิด พร้อมแสดงบรรทัดที่ผิด 
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5. การคอมไพล์โค้ดลงบอร์ด 

 5.1 เลือกบอร์ดคอมไพล์ คือการสื่อสารว่าช่องเสียบ Port USB ให้บอร์ดและหมายเลขพอร์ตตรง

กับท่ีพบในกรณีคอมเครื่องนี้เลือก Com3 

 
ภาพที่ 4.12 การเลือกบอร์ดคอมไพล์ 
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5.2 กด คอมไพล์ ที่ปุ่มสีเหลือง ตามภาพ  4.13 

 
ภาพที่ 4.13 เมื่อกด คอมไพล์ 
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5.3 หากไม่พบข้อผิดพลาด จะแสดงผลดังภาพ  4.14 

 
ภาพที่ 4.14 เมื่อคอมไพล์สำเร็จ 
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6. สร้าง Line Notify 

 6.1 ไปที ่https://notify-bot.line.me/ แลว้คลิกตามรูป 

 
ภาพที่ 4.15 หน้าต่าง https://notify-bot.line.me/ 

6.2 คลิก “Generate Token” เพ่ือสร้าง Token สำหรับแจ้งเตือนไปที่กลุ่ม 

 
ภาพที่ 4.16 หน้าต่าง คลิก “Generate Token” 

https://notify-bot.line.me/
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ภาพที่ 4.17 หน้าต่างเมื่อ “Generate Token” 
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  6.3 คัดลอก Code Token เพ่ือนำไปใช้งาน 

 
ภาพที่ 4.18 หน้าต่าง Copy Code Token 
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7. การสร้าง Firebase 

7.1 การสร้างโปรเจ็คใน Firebase ไปที่ https://firebase.google.com/ คลิก “Get Started” 

 
ภาพที่ 4.19 หน้าต่าง https://firebase.google.com/ 

 7.2 คลิก “เพ่ิมโปรเจ็ค” เพ่ือกำหนดโปรเจคใหม่ขึ้นมา 

 
ภาพที่ 4.20 หน้าต่างตอนเพิ่มโปรเจ็ค 
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7.3 ตั้งชื่อโปรเจ็ค แล้วคลิก “ต่อไป” 

 
ภาพที่ 4.21 หน้าต่างตอนกำหนดชื่อโปรเจ็ค 

 7.4 ในหน้า “กำหนดค่า Google Analytics” เลือก “Default Account for Firebase” แล้ว 

เลือก “สร้างโปรเจ็ค” 

 
ภาพที่ 4.22 หน้าต่างตอนกำหนดค่า Google Analytics 
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 7.5 เมื่อเสร็จแล้วเลือก “ดำเนินการต่อ” 

 
ภาพที่ 4.23 หน้าต่างเมื่อเสร็จแล้ว 

8. สร้างฐานข้อมูล 

 8.1 ไปที่เมนู Database กดเลือก “สร้างฐานข้อมูล” เพ่ือเป็นการสร้างฐานข้อมูลใหม่ขึ้นมา 

 
ภาพที่ 4.24 หน้าต่าง เลือก Database 
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ภาพที่ 4.25 หน้าต่างสร้างฐานข้อมูล 

 

2. ผลการปฏิบัติงานที่ได้รับมอบหมาย 

ในการฝึกสหกิจครั้งนี้ ได้ฝึกงานในด้านของ IT Support ซึ่งมีงานหลานอย่างที่ได้รับมอบหมาย ดังต่อไปนี้ 

2.1 ตรวจ data center 

การตรวจ Data Center นั่นเพื่อตรวจสอบไม่ให้เกิดความผิดพลาดของระบบในโรงพยาบาล

มหาวิทยาลัยเทคโนโลยีสุรนารี 
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ภาพที่ 4.26 การปฎิบัติงานตรวจ Data center                        

 

2.2 การติดตั้งคอมพิวเตอร์ 

การติดตั้งคอมพิวเตอร์ จากเครื่องเก่าที่หมดสัญญา ให้กับทุกแผนกในโรงพยาบาลมหาวิทยาลัย

เทคโนโลยีสุรนารี 

 
ภาพที่ 4.27 การปฎิบัติงานติดตั้งคอมพิวเตอร์           
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2.3 การรับ Job Reqeust 

การรับ Job Reqeust ที่ผู ้ใช้งานในแผนกต่าง ๆจะแจ้งปัญหาการให้งานเข้ามาและทำการ 

consult Job ต่าง ๆให้กับพ่ีที่รับผิดชอบ 

 
ภาพที่ 4.28 การรับ Job Reqeust 

2.4 เข้าร่วมกิจกรรม 

        เข้าร่วมกิจกรรมต่าง ๆของโรงพยาบาลเช่น กิจกรรมงานกีฬาสีบุคคลากรโรงพยาบาลมทส, 

กิจกรรม Open House 

 
ภาพที่ 4.29 เข้าร่วมกิจกรรม 



บทที่ 5 

สรุปผลการดำเนินโครงการปฏิบัติงาน 
        จากการศึกษาและพัฒนาระบบต้นแบบการแจ้งเตือนยาฉุกเฉิน แผนกเภสัชกรรม โรงพยาบาล

มหาวิทยาลัยเทคโนโลยีสุรนารี พบว่าสามารถเป็นต้นแบในการพัฒนาระบบต่อไป เพ่ือความสะดวกของ

แผนกเภสัชกรรม โรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารี 

1. สรุปผลการดำเนินโครงการ 

การศึกษาระบบการแจ้งเตือนยา Stat เพื่อเช็คให้ยานั้นเพียงพออยู่ในเกณฑ์ที่กำหนดเพื่อไม่ให้

เกิดกรณียาหมดทำให้ทราบถึงประโยชน์จากการศึกษาระบบการเรียนรู้ การเขียนโค้ด รวมถึงความรู้ที่ได้

จากพ่ี ๆ แผนกเภสัชกรรม 

การศึกษาระบบต้นแบบการแจ้งเตือนยา Stat โดยการนำเทคโนโลยีของสรรพสิ่งหรือ IOT มาใช้

โดยการพัฒนาจากบอร์ด Arduino และ Loadcell ในการชั่งน้ำหนักยา เพื่อแจ้งเตือนผ่าน Line Notify 

และผ่านไฟ LED เมื่อยามีปริมาณน้อยกว่ากำหนด  

 จากการที่ผู้พัฒนาศึกษาและออกแบบต้นแบบระบบการแจ้งเตือนยา Stat ให้กับแผนกเภสัช

กรรมโรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารีนั้น ได้สร้างประโยชน์ให้กับทางโรงพยาบาลเพื่อที่จะได้

ศึกษาต่อยอดในด้ายการแจ้งเตือนยา Stat ได้มีประสิทธิภาพมากยิ่งขึ้น สะดวกและประหยัดเวลาในการ

ปฏิบัติงานของบุคคลากร 

2. วิเคราะห์ปัญหาจากการดำเนินโครงการ 

2.1 ในด้านของระบบจากการวิเคราะห์และศึกษาระบบปัญหาที่พบคือ การชั่งน้ำหนักยาที่มีค่า 

น้ำหนักน้อยหรือต่ำนั้น ทำให้อุปกรณ์ในการชั่งน้ำหนักขาดความเสถียร แม่นยำในการกำหนดค่าจริงใน

การชั่งน้ำหนัก ซึ่งส่งผลโดยตรงในการประมวลค่าน้ำหนักเพ่ือนำมาแจ้งเตือน 

 2.2 ในด้านผู้จัดทำ ผู้จัดทำระบบต้นแบบการแจ้งเตือนยา stat แผนกเภสัชกรรม โรงพยาบาล

มหาวิทยาลัยเทคโนโลยีสุรนารีนั ้น เป็นการศึกษาระบบครั้งแรกที่เกี ่ยวกับ บอร์ดอาดูโน่ ซึ ่งอาจขาด

ประสบการณ์ ความรู้ ในการ ศึกษาและพัฒนา หากมีประสบการณ์ความรู้มากกว่านี้อาจพัฒนาระบบได้ดี

ยิ่งขึ้น  

3. ข้อเสนอแนะและแนวทางการแก้ไขปัญหา 

 3.1 ควรศึกษาและเรียนรู้การใช้งาน Load Cell และศึกษาการชั่งน้ำหนักเพ่ือให้มีความแม่นยำ

ในการประมวลผล 

3.2 ควรศึกษาเพ่ิมเติมการแจ้งเตือนด้วย Line Notify หาดเกิดข้อผิดพลาดในการแจ้งเตือน 
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3.3 ควรศึกษาและเรียนรู้การใช้งาน บอร์ด Arduino กับการ Coding กำหนดค่าของระบบให้

มีประสิทธิภาพมากยิ่งขึ้น 

3.4 การพัฒนาต้นแบบระบบการแจ้งเตือนยา Stat ยังไม่สมบูรณ์เท่าที่ควร เนื่องจากผู้พัฒนา

ระบบยังขาดประสบการณ์ในการวิเคราะห์และออกแบบระบบ รวมไปถึงการแจ้งเตือน หากนำระบบไป

ใช้ในองค์กร ต้องศึกษาระบบการทำงานและปรับเปลี่ยนข้อมูลหรอโปรแกรมบางส่วน เพื่อให้เหมาะสม

และมีประสิทธิภาพมากที่สุดต่อองค์กร 

3.5 สำหรับผู้ที่จะพัฒนาระบบต่อไปควรศึกษาเพ่ิมเติมหรือทดลองใช้ Load Cell แบบอ่ืน ๆ ที่

นำมาใช้งานให้มีความเสถียรมากยิ่งข้ึนเพื่อนำมาต่อยอดในการใช้งานจริง 

3.6 สำหรับผู้ที่จะพัฒนาระบบต่อไปควรศึกษาเพิ่มเติมในเรื่องอายุการใช้งานของอุปกรณ์ว่ามี

ระยะเวลาเท่าไหร่ใรการใช้งานได้เต็มประสิทธิภาพ 

3.7 สำหรับผู้ที่จะพัฒนาระบบต่อไปควรศึกษาเพิ่มเติมเกี่ยวกับระบบที่เกี่ยวข้องหรือคล้ายกับ

ระบบต้นแบบการแจ้งเตือน ว่าเหมือนหรือมีประสิทธิภาพต่างกันอย่างไร  

3.8 สำหรับผู้ที่จะพัฒนาระบบต่อไปควรเพิ่มเติมในเรื่องงบประมาณต้นทุนในการออกแบบ

ระบบ เพื่อเป็นต้นแบบในการนำเสนอโครงการต่อโรงพยาบาลมหาวิทยาลัยเทคโนโลยีสุรนารีต่อไป 

3.9 สำหรับผู้ที่จะพัฒนาระบบต่อไปควรศึกษาสอบถามข้อมูลเพิ่มเติมจากหลายหน่วยงานที่

เกี่ยวข้องเช่น หน่วยงานเครื่องมือแพทย์ วิศวกร เพื่อเพิ่มเติมความรู้ในเรื่องของอุปกรณ์ทางการแพทย์

หรืออุปกรณ์ต่าง ๆจากวิศวกรที่เก่ียวข้อง 

3.10 สำหรับผู้ที่จะพัฒนาระบบต่อไปควรปรับปรุง ระบบฐานข้อมูลให้มีความละเอียด ขยาย
ขอบเขตการทำงานของระบบให้กว้างยิ่งขึ้น                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                          
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การแจ้งเตือนผ่าน Line notify 
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หลักสูตรบริหารธุรกิจบัณฑิต สาขาวิชาคอมพิวเตอร์ธุรกิจ คณะ

วิทยาการจัดการ ระดับปริญญาตรี ชั้นปีที่ 4 หมู่ 2 หลักสูตรปริญญา

ตรี 4 ปี มหาวิทยาลัยราชภัฏนครราชสีมา 

วันเดือนปีเกิด : 9 มกราคม 2541 

ที่อยู่ : 12/1 หมู่ 7 หมู่บ้านประกายปรง ตำบลหนองงูเหลือม  อำเภอเฉลิม

พระเกียรติ จังหวัดนครราชสีมา 

เบอร์โทรศัพท์ : 091-742-3932 

E-mail: 5940505307@nrru.ac.th 

หน้าที่ : จัดทำเอกสารโครงงาน ผู้ช่วยเขียนโปรแกรม วิเคราะห์และออกแบบ

ระบบ 
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ชื่อ – นามสกุล : นางสาว เสาวรัตน์ ดำขำ 

ชื่อเล่น : บี 

รหัสประจำตัวนักศึกษา : 5940505317 

โปรแกรมวิชา/คณะ 

 

หลักสูตรบริหารธุรกิจบัณฑิต สาขาวิชาคอมพิวเตอร์ธุรกิจ คณะ

วิทยาการจัดการ ระดับปริญญาตรี ชั้นปีที่ 4 หมู่ 3 หลักสูตรปริญญา

ตรี 4 ปี มหาวิทยาลัยราชภัฏนครราชสีมา 

วันเดือนปีเกิด : 25 เมษายน 2541 

ที่อยู่ : 8 หมู่ 5 หมู่บ้านดอยเจดีย์ ตำบลบึงปรือ  อำเภอเทพารักษ์ 

เบอร์โทรศัพท์ : 086-427-6788 

E-mail: 5940505317@nrru.ac.th 

หน้าที่ : จัดทำเอกสารโครงงาน ผู้ช่วยเขียนโปรแกรม วิเคราะห์และออกแบบ

ระบบ 

  


